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Computer application in business 

Unit -1 Introduction to Windows 

Windows 10 

The latest version of windows is windows10 was introduced in 2015. It is designed to 
compatible with hard ware, software and peripherals and updates that are always enabled 
help user stay up to date with features and security for the supported life time of the devise. 

Best new features 

1. Start menu and action centre: The start menu is now available in full screen instead 

of the limited in windows 8.1. The action centre has quick buttons to switch Wi-fi 

and Bluetooth on or off. 

2. Cortana desktop: Cortana, your personal digital assistant, is right on desktop. It make 

easier for user to interact with devise without lifting a finger. User will be able to to 

search hard drive for specific files pull up photos from specific dates or launch 

powerpoint presentations just by telling PC to do so. 

3. Xbox app and streaming: Gaming just got even better with windows10. Not only do 

your existing games work great, you can now play and connect with games across  

4. Xbox One and windows10 devises. 

5. Universal app: The news of universal app is good news for anyone using more than 

one windows devise. A bundle of apps including photos, videos, music, maps, people 

and messaging and mail and calendar will look and feel the same across different 

devises and screen sizes. The data will also be saved and sync automatically via 

onedrive. 

6. Snap assist helps you snap windows: A new snap assist  features also helps users 

work out which way is best to snap app to. User can snap windows into new screens 

and tile windows just as user has been able to since windows 2.0 or may be 3.0. 

7. Improvements  to windows explorer: A new home location is the new default view in 

Windows Explorer task bar. 

8. Lots of business and enterprises: This version of windows will have plenty of other 

features for enterprise, including a customised store and protection for corporate 

data. Mobile Devise Management will be able to be used for all devises. 

9. Control panel: Instead of having two apps to control your devise settings in control 

panel and PC settings, Microsoft is making things less confusing by bringing them 

together in one. It will be able to manage the devise from one place instead of 

hunting for a specific menu. 

10. Virtual desktop: In Windows 10, there is a option to use virtual desktops. If you are 

familiar with workspaces in Linux  you will feel quite at home with Windows Virtual 

Desktops. Instead of just having one Desktop per monitor you will be able to switch 

between multiple virtual desktops. 
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A closer look at the windows 

1. Start menu: Select the start icon button on taskbar. Next, make it yours by 

pinning apps and programs or moving and regrouping tiles. If you  need more 

space, resize the start menu to make it bigger. 

2. All apps and programs – Right at your finger tips: Get to file explorer, settings 

and other apps user use often from the left side of the start menu. To see all 

apps and programs, select all apps. 

3. Find all your apps and programs: The start menu is the place to find a full list of 

all of them. Select the start icon button and then select all apps in the lower left 

corner. To keep scrolling to a minimum, jump to a specific part of the list. 

4. Pin apps to the start menu: To see live updates on what’s happening in world, 

like new email, next appointment or the weekend weather. Pin an app, is added 

to the start menu as a new tile. Once pin a new app, resize it.  

5. Group your apps: After have pinned an app, move it into a group. To create a 

new group of tiles move an app’s tile up and down until a group driver appears 

and then release the tile. 

6. Make start full screen: User get either maximized or default size and even when 

maximized, the left side (all apps) list takes up a fraction of the screen. 

To make start full screen and see everything in one view, select the Start icon 

button, then Select Settings > Personalization > Start and then turn on Use Start full 

screen. 

File explorer 

File explorer previously called windows explorer helps user work with files and 

folders on one drive, PC and network. Open File explorer by swiping in from the right 

edge of the screen tapping search or if user are using mouse, pointing to the top-

right corner of the screen, moving mouse pointer down then clicking search entering 

file explorer in the search box then tapping or clicking file explorer. 

Different parts of the file explorer 

Left pane: use the left pane to get all kinds of locations, your one drive, folders on 

your PC, drives devises connected to your PC and other PC’s on your network. 

 Back, forward and up buttons: use the back button to go back to the last location or 

search results you were viewing, and the forward button to return to the next 

location or search results. Use the UP button to open the location where the folder 

you’re viewing is saved. 
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Ribbon: Use the ribbon for common tasks, such as copying and moving, creating new 

folders, emailing and zipping items, and changing the view. The tabs change to show 

extra tasks that apply to the selected items. 

Address bar: Use the address bar to enter or select a location 

File list: This is where the contents of the current folder are displayed. Its also where 

your search results appear when you enter a search term in the search box. 

Column headings: In the details view you can use the column headings to change 

how the files in the file list are organised. 

Search box: Enter a word phrase in the search box to look for an item in the current 

folder 

Status bar: Use the status bar to quickly see the total number of items in a location, 

or the number of selected items and their total size. 

Details / preview pane: Use the details pane to see the most common properties 

associated with the selected file. File properties provide more detailed into about a 

file, such as the author, the date you last changed the file and any descriptive tags 

you might have added to the file. 

Windows 7 

Windows 7 (2009) is the current major release after windows vista and was planned 

for a three year development timeframe.  

New features of Windows 7 

a) Desktop themes: Windows 7 supports for themes. In addition to settings the 

colours of the windows chrome, desktop background, desktop icons, mouse 

pointers and sound schemes, themes in windows 7 include desktop slideshow 

settings. 

b) Desktop slideshow: Windows explorer includes a desktop slideshow that changes 

the desktop background in a designated amount of time with a smooth fading 

transaction. 

c) Windows explorer libraries: Windows explorer in windows 7 supports libraries, 

virtual folders described in a .library-ms file that aggregates content from various 

locations including shared folders on networked systems. 

d) Federated search: Windows explorer also supports federating search to external 

data sources, such as custom databases or web services, that are exposed over 

the web and described via an open search definition. 

e) Thumbnail previews: Another new feature added is the ability to get a “peek” of 

the window by hovering over the thumbnail preview. Peeking brings up only the 
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window of the thumbnail preview over which the mouse hovers and turns any 

other windows on the desktop transparent. 

f) Jump list: These are menu options available from right clicking any of the icons 

on the taskbar or by holding the left mouse button and sliding towards of the 

desktop on an icon. 

g) Power saving feature: It includes power saving features, such as adaptive display 

brightness, which dims a laptop’s display when the laptop has not been used for 

a while. 

h) Devises and printers: Devises and printers is a new control panel interface that is 

directly accessible from the start menu. 

i) Desktop window manager: The desktop window manager in windows7 also adds 

support for systems using multiple heterogeneous graphics cards from different 

vendors. 

j) File system – virtual hard disks: The enterprise, ultimate and professional edition 

of windows7 incorporate support for virtual hard disk (VHD) file format. VHD files 

can be mounted as drives, created and booted from, in the same way as WIM 

files. 

k) File system-Disk partitioning: The default disk partitioning structure is to create 

two partitions, the first for booting, bit locker and running the windows recovery 

environment and second to install the operating system. 

l) Multimedia – Windows media centre: Windows7 media centre include a new 

mini guide, a new scrub bar the option to colour code the guide by show type, 

and internet content that is more tightly integrated with regular TV via the guide. 

All windows7 versions now support up to 4 turners of each type ( QAM, ATSC, 

Cable CARD, NTSC). 

m) Firewall and internet: Windows7 adds support for multiple firewall profiles. 

n)  Notification area: The notification area has been redesigned , the standard 

volume, network, power and action centre status icons are present but no other 

application icons are shown unless the user has chosen for them to be shown. 

o) Aero snap-window maximising and tiling:  Windows can be dragged to the top of 

the screen to maximize them and dragged away to restore them. Dragging a 

window to the left or right of the screen makes it take up half of the screen 

allowing the user to tile two windows next to each year. 

p) Aero shake: It allows users to clear up any clutter on their screen by shaking 

(dragging back and forth) a window of their choice with the mouse. 

q) Wireless hosted network: The windows7 wireless LAN service supports two new 

functions – virtual Wi-Fi, that would allow a single wireless network adapter to 

act like two client devises or software-based wireless access point to act as both 

a wireless hotspot and wireless client at the same time. 
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Desktop screen 

A window is a large square on the screen that represents a conversation with the 

computer is called “desktop”. 

Parts of desktop screen 

 Toaster button or control menu box: This feature is located in the upper 

left corner of each window. The toaster button is most useful when 

accessed by the key board. The command of toaster button allow you to 

change a window’s shape, position and prominence (maximized, normal, 

minimized) 

 Title bar: The title bar is at the very top of every window. This part of the 

window shows the name of the application, document, group, directory 

or file. 

 Active window: This window is special than all the other windows 

because it allows you work on it. If more than one window is open, the 

title bar for the active window has a colour or intensity different from the 

other title bars. 

 Menu bar: The menu bar contains the available menus from which you 

can chose commands. Clicking on any of the menu ban will bring up a 

corresponding pull down menu. 

 Scroll bars: The scroll bar allow you to move through a document or a list 

when the entire document or list does not fit in the window or the 

allocated space. To move up or down a document, click on the up and 

down scroll arrows. 

 Maximise / minimise buttons: These buttons are located on the upper 

right corner of the screen. The maximise button enlarges the active 

window to fill the entire desktop. The minimise button reduces the active 

window to an icon.   

 The restore button: This button replaces the maximise button after you 

enlarge a window. The restore button returns the window to the 

previous size. 

 Window border: It is the outside edge of a window. You can change the 

size of a window by lengthening and shortening the borders. Click on the 

title to see more about the windows border. 

 Work space: The work space is the area below the menu bar. To find out 

more about the window’s workspace click on the title. 

 Task bar: The taskbar is located on the bottom edge of the desktop. You 

can move other locations by dragging it. Normally it is in view all the 

time. The taskbar’s main job is to show what applications are currently 

running. 
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Start button 

The start menu button is located on taskbar, which is most commonly found on the bottom 

half of the screen. The start button launches the start menu, which is the main access point 

to both the user programs that are installed on the system and the system resources which 

control the behaviour of the operating system. 

Start menu 

The start menu is the main gateway to your computer’s programs, folders and settings. It is 

called a menu because it provides a list of choices, just as a restaurant menu does. 

Components of start menu 

1. Programs- Opens the programs menu which contains short cut to the software 

programs on the computer including Windows Accessories. 

2. Documents- Open recently used documents. Provide quick access to the last one file 

that have been opened, as well as short cut to the My Documents folder. 

3. Setting: Open a cascading menu with commands to open the control panel folder, 

printer folder, task bar properties dialog box, folder option dialog box. 

4. Search: Utility that helps to trace files, folders or computers with is the system or 

across the network. 

5. Help: It provides an integrate table of contents, an index and a full text search 

features so you can find information easily. 

6. Run: Opens the run dialog box, windows will open the program, folder, document or 

internet resource that you have typed in. There is also a browser button to help you 

find what you want to open. 

7. Shutdown: Shutdown or restart the computer with options. 

Icon  

An icon is a graphical symbol representing a window element. Icons helps to access files or 

applications quickly. 

Different types of Icons 

Desktop icons: some icons led you to important part of the computer. A number of others of 

this type may show on your desktop, depending on what has been installed. Eg: My 

computer, Network Neighbourhood, My Documents and Recycle bin. 

Document icons: Files can actually be stored as a part of Desktop. This icon represents 

documents rather than a shortcut application. There is no arrow at the bottom left like 

there is for a short cut.  
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Shortcut icons: A shortcut points to the file that runs a program, like MS WORD or to a 

document, like to the web page Astronomy pictures of the day. A shortcut can be placed 

wherever you want to put it-on the Desktop, in the folder, in the Quick Launch area.  

Windows explorer 

Windows explorer is the desktop manager, file browser and internet browser, all rolled into 

one package. Explorer is so integrated into the Windows framework that it was once a 

subject of controversy from competing internet browsers, who claimed that Microsoft was 

involved in unfair business practices. 

Parts of Windows Explorer 

1) Task pane: A Task pane is a multipurpose window pane that appears on the right side of 

the window of an office application. 

2)  Status bar: The status bar, by default, has been turned off in window XP. This bar is 

useful to windows users not only in windows explorer, but in internet explorer as well. In 

Windows explorer it shows you rudimentary file details which are specific for you file 

type. 

3) Address bar: The address bar allows the user to type in a URL or directory and move 

straight there without any further navigation as well as letting the user know where they 

are currently on the internet or file system. 

4) Standard buttons: The standard buttons operate the same way in both Windows 

Explorer and Internet Explorer. The common buttons are: 

 Back: Navigates to the last page/folder that you were viewing. 

 Forward: If you have browsed backwards using the button you may use this 

button to move forward through the views you backed out of. 

 Home: Only available on Internet Explorer; takes the user to their home page as 

specified in the Internet options. 

 Refresh: Allows you to refresh the current web page with the latest versions 

from the server, or on Windows Explorer refreshes the file list that is currently 

displayed. 

 Search: Lets you search either the internet for websites or your file system for 

certain files. 

 Stop: This button stops your browser from continuing to load the current page if 

it is in the process of doing so. This button has no function in Windows Explorer, 

even though it is present. 

 Up: Only available in Windows Explorer; this button allows you to move one 

directory up into the file system. 
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Viewing options of Windows Explorer 

Windows offers its users a variety of methods to view their files. Click on view in the 

tool bar and select your desired view to change your current mode. The variety of 

methods to view are: 

 In Details View, all the information is tightly displayed, which makes this view 

the favourite for viewing files which contain no extra information such as 

pictures or movies. 

 The List View is similar to details view, in that lists the file name, and 

associated program icon, but no preview information. 

 The Icon View displays icons, which are based on their associated program, 

and the file name. 

 The Tiles View is the same as the Icons View with the exception that it 

displays some extra information along with the file name such as: File type, 

size, picture, dimensions and music author and title. 

 The Thumbnails View is the first view which Windows decides to display 

preview information of its own. This information is usually only displayed on 

files which contain multimedia content such as: pictures (BMP, GIF, JPG etc), 

movies (MPG, ASF, AVI). 

 The Filmstrip View is excellent for browsing through multiple pictures at 

once. 

Windows accessories 

The windows accessories component is part of the start menu hierarchy. Windows provides 

several accessories, or applications, that you can use to help you in your work. 

Components of Windows Accessories  

a) Address book: The address book provides a convenient place to store contact 

information for easy retrieval from programs such as Outlook, Outlook Express, 

Internet Explorer, Net Meeting and Microsoft phone system. 

b) Calculator: You can use Calculator in standard view to do simple calculations or in 

scientific view to do advanced scientific and statistical calculations. 

c) Command prompt: You type MS-DOS commands using a command prompt window. 

To end your MS-DOS session, type exit in the command prompt window at the 

blinking cursor. 

d) WordPad: Use WordPad to edit text files or to create simple documents such as 

notes, memos, fax sheets and so on. WordPad saves files in rich text format by 

default, but you can choose to save in a text only format. 
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e) Notepad: Notepad is a basic text editor you can use for simple documents or for 

creating web pages. The most common type of simple file is a text file, which has the 

extension .txt. 

f) Using paint: Paint is a drawing tool you can use to create black-and-white or color 

drawings that you can save as bitmap (.bmp) files. 

Files, Folder and Drives. 

A File is a collection of information that is stored in a computer system and can be identified 

by its full path name. 

A Folder or Directory, is an entity in a file system which contains a group of files or 

collection of files and other directories. 

A Drive is a special type of folder. It’s special because it represents a physical device where 

files and folders are stored. 

File manager 

It is a program included with Windows 3.x, that enabled the users to manage their files on 

the computer. File manager was replaced with explorer and my computer with the 

introduction of Windows 95. 

Program manager 

It is the main window of Microsoft Windows that allows the user to execute all the 

programs on their computer. 

Program manager starts automatically when the user starts Microsoft Windows and runs as 

long as windows is in use. 

File management features-using windows explorer 

Windows explorer’s left and right panes are used in combination to perform basic file 

management operations. Files and Folders are treated identically so both will be referred to 

as “items” in this section. Basic file management includes 

1. Creating a new file or inserting a file:  

a) Use the scroll bars and expand or collapse the folder in the left pane of the 

Windows explorer until the drive or the folder under which the new file 

will be created comes in view. 

b) Click on the drive or folder in the left pane to select it. 

c) Make sure that a file is not selected in the right pane. 

d) Select the edit menu tab of the windows explorer. 

e) Select the proper file type from many sub-options. 

f) Assign a proper name to the file and press the enter key. 
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2. Opening a file 

a) Use the scroll bar and expand or collapse the file folder in 

the left pane of the windows explorer until the folder that 

contains the file comes in view. 

b) Click the folder icon in the left pane to select it. 

c) Use the scroll bars in the right pane until the file name 

appears in it. 

d) Click on the file icon to select it. 

e) Select the file menu tab. 

f) Select the open option in the file menu tab. 

3. Rename a file or folder 

a) In the left pane, select the folder containing the item you 

want to rename. 

b) In the right pane, right click on the item you want to 

rename to open a context menu. 

c) Select rename from the context menu. The name in the 

item’s text box will be highlighted and there will be a 

blinking cursor. 

d) Type the new name for the item. 

e) Press and release enter key. 

4. Delete files and folders 

a) In the left pane, select the folder containing items you 

want to delete. 

b) In the right pane, select all items to be deleted. 

c) Right click on the icon for one of the items selected for 

deletion. This opens a context menu. 

d) Select delete from the context menu. A window will 

open asking you to confirm that you want send the 

selected items to the recycle bin. Sending items to the 

recycle bin is the first step in deleting them. 

e) If you are not certain and want to cancel the operation, 

click on No. To continue, click Yes. 

5. Restore files and folders from the recycle bin 

a) In the left pane, select the recycle bin. In the right pane, you 

will see all the items available to be restored. The following 

restrictions apply. 

i. You can only restore an item to its original location. 

ii. You cannot look at or restore items contained in a 

folder that was deleted. You must restore the entire 

folder. 

b) In the right pane, select all items you want to restore. 
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c) Right click on the icon for one of the selected items you want 

to restore. 

d) Select restore from the context menu. The selected items will 

be restored to their original location. 

6. Empty the recycle bin 

a) Empty all files and folders from the recycle bin. 

i. Right click on the recycle bin in the left pane to open a 

context menu. 

ii. Select empty recycle bin from the context menu. 

iii. All files and folders in the recycle bin are deleted and 

can no longer be restored. 

b) Empty selected files and folders from the recycle bin. 

i. With the recycle bin selected in the left pane, delete 

files and folders from the right pane as you would from 

any folder. One deleted from the recycle bin they can 

no longer be restored. 

7. Finding files and folders 

a) Go to start menu and choose find, files and folders. Or 

b) Click on tools on the menu bar and choose find, files and 

folders. Or  

c) Right click my computer and choose find. 

8. Copy files and folders  

a) In the left pane, select the folder containing the items you 

want to copy to another location.  

b) In the right pane, select all the items to be copied. 

c) Right click on the icon for one of the selected items to open a 

context menu. 

d) Select copy from the context menu. 

e) In the left pane, select the folder you want to copy the 

selected items to. 

f) In the right pane, right click anywhere on the background of 

the pane to open a context menu. 

g) Select paste from the context menu. 

9. Move files and folders 

a) In the left pane, select the folder containing the items you 

want to move to another location 

b) In the right pane, select all the items to be moved. 

c) Right click on the icon for one of the selected items to open a 

context menu. 

d) Select cut from the context menu. 
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e) In left pane select the folder you want to copy the selected 

items to. 

f) In the right pane, right click in the background of the pane to 

open a context menu. 

g) Select paste from the context menu. 

10. Hide files and folders 

a) Right click on the file that you want to hide. 

b) Click properties. 

c) Click on general 

d) Check mark the hidden type box under attributes. 

e) Click apply 

f) Click ok. 
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Unit 2 

MS WORD 

WORD PROCESSOR 

A word processor is a software package that helps you to create and edit a document.  

A word processor is a program that enables you to perform word processing functions. 

Features of word processor 

1. Document creation, storage and retrieval. 

2. Type a document through the keyboard and save it on disk. 

3. Edit characters, words, lines, and images anywhere in the document. 

4. Retrieve documents from the disk. 

5. Move or copy paragraphs or images from one place in the document to another. 

6. Reduce or increase the left, right, top and bottom margins according to the requirements. 

7. Change the text font and style. 

8. Search for a particular word or phrase. 

9. Search for error in spelling and make corrections. 

10. Print a document in various formats. 

Operations in word processor 

a. Insert text: Allows you to insert text anywhere in the document 

b. Delete text: Allows you to erase characters, words, lines, or pages as easily as you can strike 

out them on paper. 

c. Cut and paste: Allows you to remove (cut) a section of the text from one place in a 

document and insert (paste) it somewhere else. 

d. Copy: Allows you to duplicate a section of text. When you copy a piece of data, a duplicate 

of that data is placed in a temporary location. 

e. Page size and margins: Allows you to define various page sizes and margins, and the word 

processor will automatically read just the text so that it fits. 

f. Search and replace: This feature supported by most word processor which lets you replace a 

character with another character wherever the first character in the document. 

g. Word wrap: This is the feature that causes the word processor to force all text to fit within 

the defined margins. 

h. Print: Allows you send a document to printer to get hard copy 

i. File management: Many word processors contain file management capabilities that allow 

you create, delete, move and search for files. 

j. Font specification: Allows you to change fonts within a document. Ex: bold, italic, underline, 

size and style etc. 

k. Foot notes and cross references: Automates the numbering and placement of foot notes nad 

enables you to easily cross references other sections of the document. 

l. Graphics: Allows you embed illustrations and graphs into a document. 

m. Headers and footers: Header is a line or lines of text that appears at the top of each page of 

a document. Once you specify the text that should appear the header, the word processor 
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automatically inserts it. Footers are one or more lines of text that appears at the bottom of 

every page of a document. 

n. Page number: The word processor automatically keeps track of page numbers so that the 

correct number appears on each page. 

o. Layout: Allows you to specify different margins within a single document and to specify 

various methods for identifying paragraphs. 

MS WORD 

MS Word is a computer program that enables you to type, modify, print and save texts for future 

revisions and retrievals. 

Objectives of MS Word 

1. Main feature is to correct the spelling as you type. Also helps to locate and correct errors 

quickly. Other features are to check grammatical errors, words, underlines the text with a 

green line. 

2. Word’s ‘auto format’ feature combined with the facility to insert symbols and special 

characters. 

3. You can arrange text in rows and columnsusing Word’s table features. 

4. To create form letters, envelops and tables you can use the mail merge features. 

MS WORD- 2007 new features 

a) User interface: It is officially known as Fluent user interface, has been implemented in the 

core Micro office applications: Word, Excel, PowerPoint, Access. 

b) Ribbon: The Ribbon, a panel that houses a fixed arrangement of command buttons and 

icons, organizes commands as a set of tabs, each grouping relevant commands, and is not 

customizable. The Ribbon User Interface is a task oriented Graphical User Interface. It 

features a central menu button, widely known as the Office Button. 

c) Contextual tabs: Some tabs called tabs, appears only when certain objects are selected. 

d) Live preview: Which is temporarily applies formatting on the focused text or object when 

any formatting button is moused-over. 

e) Mini toolbar: It is a type of context menu that is automatically shown (by default) when text 

is selected. 

f) Quick access toolbar: it is which sites in the title bar, serves as a repository of most used 

functions, regardless of which application is being used, such as save, undo/redo and print. 

g) PDF: Initially, Microsoft promised to support exporting to Portable Document Format in 

office 2007. 

h) Themes and quick styles: Microsoft office 2007 places more emphasis on document themes 

and quick styles. 

To start MS-WORD 

Start → Programs→ Microsoft office→ Microsoft office word 2007 

Different types of Bars 

1. Title bar: This tells you which application packages is currently running and which 

document is currently open. 



CAB notes 
 

SN notes Page 15 
 

2. Menu bar: This is traditional Windows style drop-down menu. When you point to any 

menu title and click once with the mouse, the menu will open, displaying all the 

commands available under the menu title. 

3. Standard tool bar: Tool bars contain buttons, drop-down menus and other controls that 

help you quickly alter the appearance and arrangement of documents by executing a 

variety word commands. 

4. Formatting tool bar: This contains icons for changing the look of your text. Here is the 

list icons and it functions 

Icon               Function  

Style menu Allows you to define a group of paragraph and character formats as a 
style. 

Font menu Click the arrowhead to the right of the font name box to view the list of 
fonts available. Scroll down to the font you want and click once to select. 

Font size Click on the white part of the font size box to enter a value for the font 
size or click the arrowhead to the right of the box to view list of font sizes 
available. Select a size by clicking on it once. 

Font style  Use these buttons to bold, italic and underline the selected text. 

Alignment  Text can be aligned to the left, center, right and justified across the page. 

Line spacing Allows you to set the amount of space between one line to another line. 

Numbering  It is used to setoff and emphasize sections of text and are presented by 
dots or numbers. 

Outside 
border 

Add a border around selected text. 

Highlight  Use this option to change the color behind a selected text. The color 
shown on the button is the last color used. To select a different color, 
click the arrowhead next to the button. 

Font color This changes the color of the text 

5. Scroll tools: These help you travel within your document. You can go anywhere, up and 

down, right and left in your document mainly by two ways: Using the horizontal and 

vertical scroll bars with the help of the mouse or using the keyboard by pressing PgUp, 

PgDn, home, end and arrow keys. 

6. Status bar: Also called the status area, this is normally the last line on your screen. This 

gives the following information about your work: 

 Current page 

 Section number 

 Current/total pages in the document 

 Current cursor position 

 Current line number 

 Current column number 

7. Ruler: The ruler lets you make changes to margins and indents and helps you create 

document as per dimensions required. 

8. Cursor: Also called “Insertion Pointer”, this denotes the place where text, graphics or 

any other item would be placed when you type, overwrite or insert them. This looks like 

a tall, skinny toothpick and keeps blinking so that you can locate it easily. 
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9. Mouse pointer: When your mouse pointer looks like an I-beam you should be able to 

move it freely about the screen. This is used for either placing the cursor at the desired 

place or choosing any command either from the menu or from toolbar. 

10. Short cut menu: A menu that displayed for a selected object. The menu contains 

commands that are contextually relevant to the selection. 

Overviewof menus 

File menu 

 

 New: creates a new blank file. 

 Open: opens or finds an existing file. 

 Close: closes the active file without exiting the application. If the file contains 

any unsaved changes, you will be prompted to save the file before closing. 

 Save: saves the active file with its current file name, location and file format. In 

case a new file is saved for the first time, the user has to specify the file name, 

location and file format. 

 Save as: saves the active file with a different file name, location or file format. 

 Save as HTML: lets you save the document as a separate file to be used for 

internet. 

 Versions: saves and manages multiple versions of document in a single file. 

 Page setup: sets margins, paper source, paper size, page orientation and other 

layout options for the active file. 

 Print preview: shows a preview of how exactly a file will look when you print it. 

 Print: prints the active file or selected items, to the selected printer or fax. 

 Send to: sends the document to a mail recipient as an e-mail. 

 Properties: displays the property sheet for the active file. 

 Exit: closes MS word after prompting you to save any unsaved files. 

Edit menu 

 Undo last command: reverses the last command i.e., undoes the effect of the last 

command you executed. 

 Repeat last command: reverses the undo command i.e., restores the last command. 

 Cut: removes the selection from the active document and places it on the clipboard 

a special place in computer’s memory from where it can be retrieved again. 

 Copy: copies the selection to the clipboard. 

 Paste: inserts the content of the clipboard at the insertion point and replaces any 

current selection. 

 Paste special: pastes links or embeds the clipboard content in the current file in the 

format you specify. 

 Paste as hyperlink: inserts the content of clipboard as a hyperlink at the insertion 

point, replacing any selection. 

 Clear: deletes the selected object or text without putting it on the clipboard. 

 Select all: selects all text and graphics in the active window. 

 Find: searches for specified text, formatting, footnotes, endnotes or comment mark 

in the active document. 
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 Replace: Searches for and replaces specific text, formatting, footnotes, endnotes or 

comment mark in the active document. 

 Goto: Locates cells that don’t match the value in the active cell in a row or column. 

 Links: Reconnects a linked object when the source file moves or is renamed. 

 Objects: Formats the line, color, fill and pattern, size position and other properties of 

the selected object. 

View menu 

 Normal: Switches to normal view, which is default document view for most word 

processing tasks. 

 Online layout: When you select online layout view, word wraps text to fit the 

window rather than the printed page. 

 Page layout: It tries to achieve “ what you see is what you get” by showing how 

elements such as graphics will be positioned on the printed page. 

 Outline: Switches to outline view, where you can examine and work with the 

structure of your file in classic outline form. 

 Toolbar: It allows you organize the commands in word, the way you want to so that 

you can find and use them quickly. 

 Ruler: Displays or hides the horizontal ruler, which you can use to position objects, 

changes paragraph indents, page margins and other space settings. 

 Document map: Turns the document map on or off, which is a vertical pane along 

the left edge of the document window that outlines the document structure. 

 Header and footer: Adds or changes the text that appears at the top and bottom of 

every page. 

 Foot notes: Footnotes explain, comment on, or provide reference for text in a 

document. 

 Comments: Displays all comments made by all reviewers in the comment pane. 

 Full screen: Hides most screen elements so that you can view more of your 

document. 

 Zoom: Enter a magnification between 10 and 200 percent to reduce or enlarge the 

display of the active document. 

Insert menu 

 Break: Insert a column, section or page break. 

 Page number: Inserts page numbers in your document pages, that automatically 

update when you add or delete pages. 

 Date and time: Inserts current date and/or current time field that is updated every 

time you open or print the document. 

 Auto text: You can use Auto text to store text or graphics you plan to reuse, such as 

product names, a company logo or a formatted table. 

 Field: Inserts a field at the insertion point. 

 Symbol: Inserts symbol and special characters from the fonts that are installed on 

your computer. 

 Comment: Inserts a comment at the insertion point. 

 Footnote: Inserts a cross reference to an item in a document. 

 Index and tables: Creates indexes, tables of contents, table of figures, table 

authorities and other similar tables. 
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 Picture: Inserts pictures from clipart and other libraries. 

 Text box: Draws a text box where you click and drag in the active window. 

 File: Inserts all or part of the file you select, into the active file at the insertion point. 

 Object: Inserts an object such as drawing, word art text effect etc., at the insertion 

point. 

 Book mark: Creates bookmark which you use to mark selected points in your 

document. 

 Hyperlink: Inserts a hyperlink through which you can jump to location in the current 

document or web page or to a different word document or web page or to a file that 

was created in a different program. 

Format menu 

 Font: Changes the font and character spacing formats of the selected text. 

 Paragraph: Changes paragraph indents, text alignment, spacing, pagination and 

other paragraph formats in the selected paragraph. 

 Bullets and numbering: Adds and modifies bullets or numbers in selected 

paragraphs. 

 Borders and shading: Applies shading effect and creates borders around selected 

area. 

 Columns: Changes the number of columns in a document or a section of document. 

 Tabs: Sets the position and alignment of tabs. 

 Drop cap: Formats a letter, word or selected text with a large initial dropped capital 

letter. 

 Text direction: Rotates selected text in table cells so that you can read from bottom 

to top or from top to bottom. 

 Change case: Changes the capitalization of selected text. 

 Auto format: Analyses the content to the active file and then automatically formats 

the file. 

 Style gallery: Provides a variety to styles which can be applied to the word 

document. 

 Style: Defines or applies to the selection a combination of formats called a style. 

 Background: Helps to chose the color of the document background. 

 Object: Formats the line, color, fill and pattern, size, position and other properties of 

the selected object. 

Tools menu 

 Spelling and grammar: Checks the active document for possible spelling, grammar 

and writing style errors and displays suggestions for correcting them. 

 Language: Designates the language of selected text in a file that contains more one 

language. 

 Word count: Counts the number of pages, words, character, paragraphs and lines in 

active document. 

 Auto summarize: Automatically summarizes the key points in the active document. 

 Auto correct: Sets the options used to correct text automatically as you type or to 

store and reuse text and other items you use frequently. 

 Look up reference: To insert lookup references and cross references. 
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 Track changes: Marks changes in the current document and keeps track of each 

change by reviewer name. 

 Merge documents: Merges the tracked changes from the active document into the 

specified document, which word opens if it is not open already. 

 Protect document: Prevents changes to all or part of an online form or document 

except as specified. 

 Mail merge: Use this option to create form letter, mailing labels or envelops with 

same or different addresses. 

 Envelops and labels: Creates an envelope or a single mailing label, or inserts the 

same name and address on an entire sheet of mailing labels. 

 Letter wizard: Runs the letter wizard, which helps you quickly create letters. 

 Macro: Opens the macro dialog box, where you can run, edit or delete macro. 

 Customize: Customizes toolbar buttons, menu commands and shortcut key 

assignments. 

 Options: Modifies settings for Microsoft office programs such as screen appearance, 

printing, editing, spelling and other options. 

Table menu: 

 Draw table: Inserts a table with the specified rows and columns, in the current 

document. 

 Insert: Inserts rows, columns and cells in the selected table. 

 Delete: Deletes the entire table (deletes the selected rows, columns or cells or the 

cell that contain the insertion point). 

 Merge cells: Combines the contents of selected adjacent cells into a single cell. 

 Split cells: Splits the selected cells into the number of rows and columns, you enter. 

 Select: Selects the table, column, rows or cells that contains the insertion point. 

 Table auto format: Automatically applies formats including predefined borders or 

shading to a table. 

 Distribute rows evenly: Changes the selected columns or cells to equal column 

width. 

 Distribute columns evenly: Changes the selected rows or cells to equal row width. 

 Heading row repeat: Designates the selected rows to be a table heading that is 

repeated on subsequent pages if the table spans more than one page. 

 Convert: Text to table converts a range of text entries in to table and vice versa. 

 Sort: Sorts a range of cells in ascending or descending order based upon selected 

criteria i.e. the column based upon which you want to sort. 

 Formula: Performs mathematical calculations on numbers. 

 Split table: Divides a table into two separate tables and inserts a paragraph mark 

above the row that contains the insertion point. 

 Hide gridlines: In a table, the gridlines commands displays or hides dotted gridlines 

to help you see which cell you are working in. 

Window menu: 

 New window: Opens a new window with the same contents as the active window so 

that you can view different parts of file at the same time. 

 Arrange all: Displays all open files in separate windows on the screen. The arrange 

command makes it easier to cut, copy and paste between files. 
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 Split: Splits the active window into panes. The user can specify the size of two 

windows. 

Help menu: 

 Microsoft word help: To launch the MS Office assistant, which provides help and tips 

to you to execute many tasks. 

 Contents and index: Gets help for you without using the office assistant. 

 What’s this? : Provides help on the topic which is clicked on. 

 Microsoft on the web: Provides a link to Microsoft’s home site containing free stuff, 

feedback, answers to frequently asked questions, technical help etc. 

 Word perfect help: Helps you learn the word equivalents for DOS commands and 

key combinations. 

 About Microsoft word: Shows you the Word’s versions details and copyright 

message along with detailed information about your computer system. 

 

Open a file 

To continue working a file you previously saved. 

Choose File→ open from the menu 

Or 

Click File →look for the file name near the bottom of the drop down menu→ click on 

file. 

Create a document (new document) 

Choose File from menu→ New option with a dialog box. 

To save a file 

Choose file menu→ click save→ in drop down save in menu select the location 

where you want to save the file→ in file name box type the name of the file you 

would like to give → click save button. 

Cut, Copy and Paste 

Cut and Paste 

In Microsoft word, you can cut text from one area of a document and place that text 

so it can be pasted elsewhere in the document. 

Technique 1- Cutting and Pasting with the menu bar 

1. Highlight the text you want to cut and paste. 

2. From the menu bar, click Edit→ Cut. 

3. Move the cursor to the place where you want to paste your text. 

4. From the menu bar, click Edit→ Paste. 

5. Your text is pasted to the new position. 

Technique 2- right click 

1. Highlight the text you want to cut and paste. 

2. Click on the highlighted text with the right mouse button. 

3. From the pop up menu, click ‘cut’. 

4. Your highlighted text is cut. 

5. Move the cursor to the place where you want to paste your text. 

6. Click the new place with your right mouse button. 
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7. From the pop up menu, click ‘paste’. 

8. Thetext is pasted to the new position. 

Technique 3- keyboard 

1. Highlight the text you want to cut and paste. 

2. Hold down Ctrl key on your keyboard. 

3. Press the latter “X” on your keyboard. 

4. The text is cut. 

5. Move the cursor to the place where you want to paste your text. 

6. Hold down Ctrl key on your keyboard. 

7. Press the latter “V” on your keyboard. 

8. The text is pasted to the new position. 

Copy and Paste 

In Microsoft word, you can copy text from one area of a document and place that 

text so it can be pasted elsewhere in the document. 

Technique 1- Copy and Paste with the menu bar 

1. Highlight the text you want to cut and paste. 

2. From the menu bar, click Edit→ Copy. 

3. Move the cursor to the place where you want to paste your text. 

4. From the menu bar, click Edit→ Paste. 

5. Your text is copied to the new position. 

Technique 2- right click 

1. Highlight the text you want to copy and paste. 

2. Click on the highlighted text with the right mouse button. 

3. From the pop up menu, click ‘copy’. 

4. Move the cursor to the place where you want to paste your text. 

5. Click the new place with your right mouse button. 

6. From the pop up menu, click ‘paste’. 

7. The text is pasted to the new location. 

Technique 3- keyboard 

1. Highlight the text you want to copy and paste. 

2. Hold down Ctrl key on your keyboard. 

3. Press the latter “C” on your keyboard. 

4. The text is copied. 

5. Move the cursor to the place where you want to paste your text. 

6. Hold down Ctrl key on your keyboard. 

7. Press the latter “V” on your keyboard. 

8. The text is pasted to the new position. 
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Formatting a Document 

Formatting a document is the way of changing the outlook of a document in way, as 

you desire. There are two major options: 

1. Formatting Font. 

2. Formatting a paragraph. 

1. Formatting font 

Applies or removes character formats from selected text or from the insertion point 

forward as you type. 

A. Fonts: Word allows us to change the font used to display text. There are several 

fonts available like Arial, Courier New, Times new Roman etc. different font sizes 

also available. 

To change the font or the size of block of text: 

 Select the block of text. 

 Select the font from the font drop down list box. 

 Select the font size from the font size drop down box. 

B. Attributes  

The main attributes are bold, underline and italics. The three most commonly 

used attributes are available as buttons on the formatting tool bar. 

To apply attributes: 

 Select the text. 

 Click B button for Bold or Ctrl-B 

 Click U button for Underline or Ctrl-U 

 Click I button for Italics or Ctrl-I 

C. Other font effects: The other effects available are Strikethrough Superscript, 

subscript to small caps and all caps. We can also use different types of 

underlining like: Double underline, dotted underline and underline only the 

words by making the appropriate selection in the underline dropdown list box. 

Other effects like shadow, outline, emboss and engrave could also be applied. 

D. Changing text color and highlighting text: The color of the text could be changed 

in font dialog box. Text could be marked by using the highlighter tool on the 

formatting tool bar. 

E. Changing case: text case refers to either capital case or small case. The case of a 

text can be changed through the change case. 

2. Formatting a paragraph 

A. Alignment of text: It means titled towards something. Aligning the text 

means that moving the text to some part of the page. 

I. Horizontal alignment: I determines the appearance and orientation 

of the text edges of the paragraph. Following are the types of 

horizontal alignment. 

 Left alignment: all the texts, which are left aligned, are written 

from the left of the page. 
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 Right alignment:all the texts, which are right aligned, are written 

from the right of the page. 

 Center alignment:all the texts, which are center aligned, are 

written from the middle of the page. 

 Justification: It is the combination of left and right alignment. 

The text appears to be balanced between left and right of a 

page. 

II. Vertical alignment: It determines the paragraph’s position relative to 

the top and bottom margins. 

B. Line spacing: It sets the amount of space between lines within a paragraph. 

Following are types of spacing. 

 Single line spacing. 

 1.5 line spacing. 

 Double line spacing. 

 At least line spacing. 

 Exactly line spacing. 

 Multiple line spacing. 

Selecting line spacing 

a. Highlight the paragraphs you wish to change to a new line 

spacing. 

b. Click Format, paragraph. 

c. In the paragraph dialog box, click Indents and Spacing tab. 

d. Select the line spacing you desire and click. 

C. When you type a letter or circular, you would like to draw the attention of 

the reader to a particular paragraph. For this, you wish to keep some space 

to the left or right of the paragraph. These extra spaces are called indents. 

D. Space before and space after: Space before sets the amount of space before 

the paragraph. Space after sets the amount of space after the paragraph. 

Spelling and grammar check 

Spell checker or spelling checker is a design feature or a software program designed to verify the 

spelling of words in a document, helping a user to ensure correct spelling. 

MS Word provides several ways to check spelling and grammar 

 Using automatic spelling and grammar checking 

 Using autocorrect feature 

Find and replace text in MS Word 

Carry out the following steps to find the required words or phrases in a word document. 

 Press Ctrl-F, which is a short cut for the Edit→ Find menu option. 

 The find and replace dialog box opens with the find tab selected. 

 Enter the text in the Find what text box. 

 Choose the Find Next command button to search for the required text. 
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Find and replacing text 

Word has an excellent features that Finds words and phrases and replaces them with other text. 

In order to do so carry out the following steps. 

 Press Ctrl-H, which is a shortcut for the Edit→ Replace menu option. 

 The Find and Replace dialog box opens with the Replace tab selected. 

 Enter the required text in the Find what text box. 

 Enter the replacement text in the replace with dialog box. 

 Choose the Find Next command button. 

Header and Footer 

Lines of text displayed below the top margin or above the bottom margin of each page are called 

headers and footers. 

Steps to insert Headers and Footers  

 Select View→ Header and Footer from the menu bar. The Header and Footer tool bar will 

appear and the top of the page. 

 Type of heading in the header box. You may use many of the standard text formatting 

options such as font fact size. 

 Click the insert auto text button to view a list of quick options available. 

 Use the other options on the tool bar to add page number the current date and time. 

 To edit the footer, click the switch between header and footer button on the tool bar. 

 When you are finished adding header and footer, click the close button on the tool bar. 

Mail Merge 

In general sense, mail means letter sent through post offices and merge means combining two or 

more things together. So mail merge is the process of combining two documents together to form a 

single and meaningful document. 

It is used to quickly create five different types documents, which are following. 

 Letters – Send letters to a group of people. You can personalize the letter that each person 

receives. 

 E-mail message – Send e-mail messages to a group of people. You can personalize the e-mail 

message that each person receives. 

 Envelopes –Print addressed envelopes for a group mailing. 

 Labels – Print address labels for a group mailing. 

 Directory – Create a single document containing a catalog or printed list of addresses. 

Steps in the Mail-Merge process 

Step 1: Choose Document type and file name: Choose the type of document you want to merge 

information into the Mail Merge task pane. After choose, click ‘Next’ at the bottom of the text pane. 
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Choose the main document you want to use. If your main document is already open, or you are 

starting with blank document, you can click Use the current document. 

Step 2: Connect to a data file and select records: In this step in Mail Merge process, you connect to 

the data file where the unique information that you want to merge into your documents is stored. 

Choose the records in the data file that you want use. After you connect to the data file that you 

want to use or create a new data file, the Mail Merge Recipients dialog box opens. You can select a 

subset of records for your Mail Merge by sorting or filtering the list. 

Step 3: Add fields to the main document: If your main document is still blank, type the information 

that will appear in each copy. Then, add fields by clicking the hyperlinks in the task pane. 

Match fields: Fields are placeholders that you insert into the main document at locations where you 

want unique information to appear. 

Step 4: Preview the merge and then complete it: 

Preview the merge: You can preview your merged documents and make changes before you 

actually complete the merge. 

Complete the merge:Now what you it depends on what type of document you are creating. 

Table  

A table is made up of rows and columns of cells that you can fill with text and graphics. 

To create a table- using insert table icon 

Place the cursor at the location you wish to place the table. Click on Insert Table icon on the 

standard toolbar and drag the mouse over the grid to select the number of rows and columns you 

are required. 

Steps of editing MS-Word table 

a) To enter text into a MS-Word table: Click on any cell and start typing text or number to the 

table. To move from cell to cell use the Tab key or mouse click. 

b) To resize column widths and row heights: Change the column widths and row heights by 

clicking the cell dividers and dragging them with the mouse. 

c) Aligning data/text in a cell: Click on the formatting palette or the formatting toolbar to align 

text. You can click on ‘align left’, ‘align right’, or ‘justify’. 

d) To select a column or multiple columns: Move the mouse pointer to the top of the column 

and the cursor will change from an I-bean to a small, thick downward pointing arrow. Click 

to select the column. If you wish to select multiple columns, just drag the mouse across the 

columns. 

e) To select a row or multiple rows:Move the mouse pointer to the left of the outside table row 

you wish to select,  and the cursor will change from an I-bean to a small, thick  pointing 

arrow left to right. Click to select the row. If you wish to select multiple rows, just drag the 

mouse across the rows. 
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f) To select the whole table: Click anywhere inside the table. From the table menu, point to 

select and click on table. 

g) To insert a column or row into the table: From the existing table, select the column or row 

where you want the new one to appear. From the table menu point to insert and select the 

appropriate options: columns to the left or columns to the right or row above or row below. 

h) To delete a column or row from the table: select the column(s) or row(s) you want to delete. 

From the table menu, point to delete and select either columns or rows. 

i) To merge cells: Select the cells you wish to combine to make a single cell. From the table 

menu, click merge cells. 

j) To split cells in a table: To split cells into two or more cells, select the cells you want to split. 

From the table menu click split cells. From the split cells dialog box displayed enter the 

number of columns or rows you wish to split the cell into and then select ok or press enter. 
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Unit 3 

MS EXCEL 

Insert Format Data menu Window menu Help 

Cells 
Rows  
Columns 
Worksheet 
Charts 
Page break 
Function 
Name 
Comment 
Picture 
Map 
Object 
hyperlink 

Cells 
Rows 
Column 
Sheet 
Auto format 
Conditional 
formatting 
Style 

Sort 
Filter 
Form 
Subtotals 
Validation 
Table 
Text to columns 
Template 
wizard 
Consolidate 
Group and 
outline 
Get external 
data 

New window 
Arrange 
Hide 
Unhide 
Split 
Freeze panes 
 

Microsoft excel 
help 
Contents and 
index 
What’s this? 
Microsoft on 
the web 
Lotus 1-2-3 help 
About Microsoft 
excel 

 

Move and copy a work sheet data 

Move worksheet data 

1. Select the cell or cell range that are to be moved. 

2. Select the Edit tab from the Excel main menu. 

3. Select the cut option. A moving border appears around the selection. 

4. Place the cell selector on the upper left hand cell of the paste area. 

5. To move the data, choose Paste from Edit menu. Data is moved from the source area 

to the destination. Any existing data in the paste are replaced. 

6. The selection is cancelled and moving border is not longer visible once the move is 

completed. 

Copy worksheet data 

1. Select the cell or cell range that are to be moved. 

2. Select the Edit tab from the Excel main menu. 

3. Select the copy option. A moving border appears around the selection. 

4. Place the cell selector on the upper left hand cell of the paste area. 

Graphics in worksheet 

Graphics may mean drawings, pictures. Clipart, word art, auto shapes, graphics and 

charts. 

Types of charts 
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1. Column charts: these are excellent when you need to compare categories. Good at 

showing changes over time, with time as the X-axis. 

2. Bar charts: These are similar to column charts but the bars extended horizontally 

instead of vertically. 

3. Cylinder, cone and pyramid charts: These are just like column charts, but use cones, 

cylinders, or pyramids instead of rectangles. 

4. Line charts: Best show changes in a series over categories or time. Suggests that the 

data is continuous, so if you were to measure a point between two points the line 

would be correct. 

5. Pie charts: Best for showing percentages of the whole. Use the exploded pie choice 

to emphasize a particular category. 

6. Scatter charts: Used to show correlations between two sets of values, one on X-axis 

and one on Y-axis. 

7. Area charts: Best for when you want to show a change over time but emphasize the 

total of all the series combined. This is like the combination of a line chart and pie 

chart. 

8. Doughnut charts: just like comparing multiple pie charts, you see how two series 

contributed to their wholes and comparisons of amounts. 

9. Rader charts: Uses a separate axis for each category radiating out from the centre. 

10. Surface charts: These use three axes to show three sets of data interact. 

11. Bubble charts: Very similar to scatter charts, but the size of the dot at each point 

reflects another dimension of the chart. 

12. Stock charts: Used specifically for charting stock activity. 

Crating a chart or graphs 

1.  If Excel is already open on your workstation open a new excel workbook. 

2.  Enter the data into the worksheet and highlight all the cells that will be included in 

the chart including headers. 

3. Click chart wizard button on the standard toolbar to view the first chart wizard dialog 

box. 

4. Chart type: Choose the chart type and the chart sub type if necessary. Then click 

‘Next’. 

5. Chart source data: Select the data range and click ‘Next’. 

6. Chart option: Enter the name of the chart and titles for the X-axis and Y-axis. Other 

options for the axes, grid lines, legend, data labels and data table can be changed by 

clicking on the tabs. Press ‘Next’to move to the next set of options. 

7. Chart location: Click as new sheet if the chart should be placed on a new, blank 

worksheet or select as object in if the chart should be embedded in an existing sheet 

and select the worksheet from the drop-down menu. 

8. Click ‘Finish’ to create the chart. 
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Formula in MS-Excel 

In MS-Excel, formula option includes numbers, cell references, functions, operators and 

parentheses. A formula entry always begins with an equal (=) sign. 

Writing the formula 

Writing Excel formulas is a little different than the way it is done in math class. Excel 

formulas starts with the equal (=) sign rather than ending with it. 

Steps of entering formula in MS-Excel 

Step 1: Entering the data: It’s best if you first enter all of your data into the spreadsheet 

before you begin creating formulas. This way you will know if there are any layout problems 

and it is less likely that you will need to correct your formula later. 

Step 2: Add the equal (=) sign: When creating formulas in Microsoft Excel, you always start 

by typing the equal sign. You type it in the cell where you want the answer to appear. 

Step 3: Add cell references using pointing: After typing the equal sign in step-2, you have 

two choices for adding cell references to the spreadsheet formula. 

Functions in MS-Excel 

Functions carry some specific work. It minimizes a large work. A function can be of two 

types that are: 

a) User defined function: A user defined functions are defined by the user for their 

specific purpose, which is not available for other users. 

b) System defined function: System defined users are available to all users by default 

and they provide some general purpose functionalities. Following are some types of 

system defined functions and their examples. 

I. Mathematical function: 

A. SUM(): this function calculates sum of the value in the given range. 

For example, =SUM(A1:A5) 

B. Autosum: it is built in function in Ms-Excel by which we can find out of the 

numbers in selected range of cells. Its icon is ∑. 

C. AVERAGE(): This function calculates average of the values in given range. 

For example, =AVERAGE(A1,A2,A3,A4) 

D. MAX(): Finds out the largest value in the given range. 

For example, =MAX(A1,A2,A3,A4) 

E. MIN(): Finds out the smallest value in the given range. 

For example, =MIN(A1,A2,A3,A4) 

F. COUNT(): Counts the number of cells that contains numbers in the specified 

range. For example, =COUNT(B5:B10) 
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II. Date function 

a) Date (year, month, day): Returns the serial number corresponding to the 

given date. 

b) NOW (): Returns the serial number of the current date and time. 

c) CTRL+: (colon)-It returns current time in the cell. 

d) CTRL+; (semi colon)- It returns date in the cell. 

III. Text function 

1) LEFT(): It returns the string from the left. For Example =LEFT(”Father”,3) the 

result is ‘Fat’. 

2) MID(): It returns value of a string from the middle. For Example 

=MID(”Father”,3,3) the result is ‘the’. 

3) RIGHT(): It returns the string from the right. For Example =RIGHT(”Father”,3) 

the result is ‘her’. 

4) LEN(): Returns the number of characters in the given string.For Example 

=LEN(“INDIA”,) the result is 5. 

5) PROPER(): Returns a string to proper case, which means that all the strings 

will be displayed with each of the words first letter being capital. For 

example =PROPER(“I love Indial”), the result is I love India. 

6) REPT(): Repeat a given character to given number times. For example 

=REPT(“*”,5), it display five *. 

7) UPPER(): Displays given string in capital letters. For example =UPPER(“india”), 

the result is INDIA. 

8) LOWER(): Displays given string in small letters. For example 

=LOWER(“INDIA”), the result is india. 

IV. Logical function 

IF (condition, true result, false result): It is used to make logical decisions. If the 

condition provided is true then it displays the result which is provided at first and if 

the condition is false then it displays the result which is provided at the last. 

For example, =IF(A5<100,”GOOD”,”BAD”). Suppose, A5 contains value 50, the result 

is ‘GOOD’. 

Formatting in MS-EXCEL 

Formatting cells 

Formatting a cell provides some facilities by which we can change the types of data entered 

in cell. Changing alignment, changing orientation, word-wrap, merging cells, font 

management, adding or removing borders, supplying patterns, protecting the cell, 

formatting columns and worksheets are some of the functionalists provided in formatting 

the cell. 
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Alignment 

Alignment means tilted towards something. We can align the text means that we are 

moving the text to some part of the page. Example Right, Left, Centre etc. 

Orientation 

Text can be written in any direction and any angled inclination. So, the way of writing the 

text in any direction is called orientation. 

Word wrap 

This is the facility available in format>cells>alignment>wrap text, by which we can manage 

text flow inside a cell. 

Shrink to fit 

When we select ‘Shrink to fit’, increase or decrease the font size in the cell in order to make 

the current worksheet fit in the page. If we select ‘Auto fit’, the row height is increased or 

decreased but fonts are unchanged. 

Merge cells 

Making two or more cells into one cell is called merging cells.  

Font management 

Using this facility, we change font types, its size, colour, type of underline and font effect. 

Border and frames 

In this option, we can add or remove borders in the worksheets, change width of border 

lines, colour of borders. 

Patterns 

By using this option, we can supply background colour, pattern and design or any pictures in 

the cell, selected range or to the whole worksheet. 

Formatting row and columns 

Using this facility, we can change width of column/row, hide the column/row and its 

content and unhide column/row etc. 
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Unit IV 

MS POWER POINT 

INTRODUCTION 

Power point is a component of Microsoft office that is used to create professional quality 

presentations. Power point is the best selling presentation graphics software package in the 

world. Power point’s innovative tools and easy approach can help you make professional 

looking presentation quickly and easily. 

Functions of presentation package 

1. Helps in making audience handouts. 

2. Free hand drawing- Drawing tools are available to add temporary annotations to the 

slides. 

3. Slide preparation which can contain text, graphics, charts, sound and video. 

4. It has built in features like context sensitive, auto layouts, wizards and a host of 

templates that help to make quick presentation. 

Applications of presentation 

1. Presentation packages are used in almost all areas where the organisation has to 

project itself to have its own identity in the competitive market. 

2. It can be used to have electronic presentation of the data that can be run on a 

computer screen or on a projection device in front of audience. 

3. It can publish the slide shows on the web which enables any organisation to 

represent their attractive presentations available on the internet to make it 

worldwide. 

4. Advertising companies for sophisticated slides are used to represent professional 

looking electronic presentation about a product. 

5. Educational institutes use it to represent about their projects, seminars, research 

topics, etc. 

Features of MS POWER POINT 

 Better organisation charts and new diagram types- Organisation charts now use the 

drawing tools in power point, resulting in smaller fields sizes and easier editing. Also 

it includes a new gallery of common conceptual diagrams. 

 Save background or selection as picture- When you want to create a presentation 

using the drawing tools in power point, you can save it as a picture by right click it. 

You can also save a texture or picture background from a slide in the same way, that 

makes it easy to reuse these graphic elements. 
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 Insert multiple pictures- when you want to insert pictures from files on hard disk 

drive, you can select multiple pictures and insert them all at once. 

 Picture rotation- you can rotate and flip types of image file in a power point 

presentation including bitmaps. 

 Support for audio and video- sounds and videos that you include in a presentation 

broadcast are heard and seen by the audience, both in real time or when archives. 

 Error prevention and recovery- documents you are working on can be recovered if 

the program encounters an error or stops responding. The documents are displayed 

in the document recovery task pane the next time you open the program. 

Overview of menus 

File menu Edit menu View menu Tools menu 

New 
Open 
Close 
Save 
Save as 
Save as HTML 
Page setup 
Print 
Send to  
Properties 
Exit  

Undo last command 
Repeat last 
command 
Cut 
Copy 
Paste 
Paste special 
Paste as hyperlink 
Clear  
Select all 
Find  
Replace 
Go to  
Links 
Object  

Tool bar 
Ruler 
Guides 
Header and footer 
Comments 
Zoom 

Spelling 
Style checker 
Language 
Auto correct 
Look up reference 
Macro 
Customise 
Options  

 

Format menu Insert menu Window menu Help menu 

Font 
Bullets and 
numbering 
Alignment 
Line spacing 
Change case 
Replace fonts 
Colours and lines 
Objects  

Date and time 
Symbol 
Comment 
Text box 
Chart  
Table 
Object 
Hyperlink 

New window 
Arrange all 
Fit to page 
Cascade 
Presentation  

Microsoft power 
point 
Contents and index 
What’s this? 
Microsoft on the 
web 
About Microsoft 
power point 
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File menu:  

Pack and go- Starts the pack and go wizard, which helps you to pack up a presentation so 

that you can run it on another computer. 

Edit menu 

Duplicate –makes a quick copy of the selected object. 

Delete slide- deletes the current slide. Deletes the selected slide in slide sorter or normal 

view.  

View menu 

Slide- enables you to see each slide, one at a time and edit each slide format, colour style 

format. 

Outline –enables you to edit and display all your presentation text in a location instead of a 

slide at a time. 

Slide sorter –displays miniature version of all slides in a presentation, complete with text 

and graphics in slide sorter view, you can reorder slides, add transition and animation 

effects etc. 

Notes page –displays the note page for the selected slide, where you can create speaker 

notes for the slide. 

Slide show –runs your slide show, beginning with the current slide if you are in slide view. 

Master –displays the master slide, where you can set the default layout and formatting for 

all slides. 

Black and white –shows the active presentation in black and white. 

Slide miniature –turns on or off slide miniature window, which displays a miniature versions 

of the current slide, complete with text and graphics. 

Speaker notes –your slides can have space for speaker notes that you can print and use 

during your presentation.  

Insert menu 

New slide –promotes you to click a slide layout and then inserts a new slide after the active 

slide. 

Duplicate slide –inserts a copy of the current slide after the current slide. 
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Slide number –adds the slide number to an individual slide. 

Slides from files –inserts slides from another presentation into the current presentation. 

Slide from outline –creates slides for all first level headings in an imported outline and adds 

the body text as indent level. 

Picture –inserts pictures from clipart and other libraries. 

Movies and sounds –inserts videos and sounds from clip gallery, movie files or audio CD’s to 

your slide during show. 

Format menu 

Slide layout –changes the layout of the selected slide. 

Slide colour scheme –reapplies or modifies the existing colour scheme or changes to 

different colour scheme. 

Background –adds different kinds of backgrounds to the document to make them look more 

interesting. 

Apply design –templates applies one of the power point design templates to your 

presentation or uses one of your own presentation as template. 

Tool menu 

Auto clipart –scans your presentation and make recommendations as to the type of digital 

images you want to use to convey your message. 

Power point central –launches an outline magazine for power point users that contains 

articles and tips on how to create better presentation. 

Presentation conference –runs a presentation over a network on the internet. 

Meeting minder –opens the meeting minder, where you can take meeting minutes and 

record action items during slide show. 

Expand slide –each paragraph on the selected slide appears as a title on a new slide. 

Slide show 

View show –runs your slide show, beginning with the current slide if you are in slide view or 

the selected slide if you are in slide sorter view. 

Rehearse timings –runs your slide show in rehearsal mode, in which you can set or change 

the timing of your electronic slide show. 

Record narration –adds voice narration to your slide show. 
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Set up show –set options for running your slide show. 

View on two screens –helps in controlling a presentation from one computer while you 

show it on another. 

Action buttons –inserts various option buttons, where you click or drag in the active window 

and then opens the action settings dialog box, where you can assign an action to the button 

Present animation –you will find various sub options within this by which you can apply 

various animation actions as per your slide. 

Custom animation –adds or changes animation effects on the current slide. 

Animation preview –runs all animation effects for the current slide in a slide miniature 

window. 

Slide transition –adds or changes the special effect that introduces a slide during a slide 

show. 

Hide slide –you can hide the selected slide and current slide if you are in slide sorter view 

and slide view respectively. 

Custom shows –creates a custom show – a presentation within presentation. 

Create a template 

Power point comes with two types of templates 

Deign templates: It contains predesigned formats and colour schemes you can apply to any 

presentation to give it a particular look. 

Content templates: It contains formats and colour schemes just like design templates, plus 

slides with suggested text for specific subjects. 

Create design template 

1. Opens an existing presentation, or use a design template to create a presentation as 

a basis for your new design template. 

2. Change the template or presentation to suit your needs. 

3. On the File menu, click Save as. 

4. In the File name box, type a name for your design template. 

5. In the Save as type box, click Design Template. 

Create a content template 

1. Open an existing presentation or template that you want to base your new template 

on. 
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2. Change the presentation or template to suit your needs. 

3. On the File menu, click Save As. 

4. In the Save as type box, click Design Template. 

5. In the File name box, enter a name for the new template, and then click Save. 

Slide 

A slide is a page, document or template where all the content of a presentation is written. It 

is just like a page of paper or page of slide show. A single page in the slide show 

presentation is known as a slide. 

Different views of slide 

Normal view –Switches to normal view, where you can work on one slide at a time or 

organise the structure of all the slides in your presentation. 

Outline view –Switches to outline view, where you can work with the structure of your file 

in outline form. 

Slide view –Switches to slide view, where you can work on one slide at a time. 

Slide sorter view –Displays miniature versions of all slides in a presentation, complete with 

text and graphics. 

Slide show view –Runs your slide show in a full screen, beginning with the current slide if 

you are in slide view or the selected slide if you are in slide sorter view. 

Multimedia  

Multimedia has become a popular technology in the ever changing world of computers. 

Multimedia can be considered any presentation that involves two or more media such as 

text, graphics, image, video and audio in computer. 

Insert Music or Sound on a slide 

1. Display the slide you want to add music or sound to. 

2. On the insert menu, point to Movies and Sounds. 

3. Do one of the following: 

 To insert a sound from clip gallery, click sound from gallery and then locate and 

insert the sound you want. 

 To insert a sound from another location, click sound from file, locate the folder that 

contains the sound, and then double click the sound you want. 

 A sound icon appears on the slide. 

4. A message is displayed. If you want the sound to play automatically when you go to 

the slide, click yes; if you want the sound to play only when you click the sound icon 

during a slide show, click no. 
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5. To preview the sound in normal view, double click the sound icon. 

Insert a video in a slide 

1. Display the slide you want to add the video to. 

2. On the insert menu, point to movies and sounds. 

3. Do one of the following: 

 To insert a video from clip gallery, click movie from gallery and then locate and insert 

the video you want. 

 To insert a video from another location, click movie from file, locate the folder that 

contains the video, and then double click the video you want. 

4. A message is displayed. If you want the movie to play automatically when you move 

to the slide, click yes; if you want the movie to play only when you click the movie 

during a slide show, click no. 

5. To preview the movie in normal view, double click the movie. 

Microsoft Outlook 

Microsoft Outlook is a personal information manager from Microsoft, available as a part 

of the Microsoft Office suite. Primarily an email application, it also includes a calendar, 

task manager, contact manager, note taking, journal, and web browsing. 

Microsoft Outlook includes extra features like: calendar, contact manager and journal 

which help you keep a details of email interactions you want to remind. It allows users 

sending/receiving emails through free POP3/IMAP and SMTP email Server also store 

contacts, journals, calendars and notes, etc. 

The highlight of Outlook features is its organized system of email 

management. Outlook allows you to organize your emails according to your user and 

client accounts. Business operations include a constant flow of communication; staff 

queries, client orders, management reports and so on. 

Top 15 Features Of Microsoft Outlook 

A lot of helpful functions are available in MS Outlook that make it more poplar comparison 
to other desktop email clients. 

1) Faster Email Processing: MS Outlook allows sending or receiving emails quickly without 
taking extra time. A user can read their emails through MS Outlook even if the internet 
connection is not available for a while. One such feature of MS Outlook helps making 
communication faster and effective. 

2) Email Attachment Reminder: It is another strong feature of the MS Outlook program that 
remind users to add or insert attachment to the email message even if user forgot to do so. 
Thus, this feature will be very helpful for people who are usual for this kind of working way 
as now MS Outlook will remind them to add required attachments. 
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3) Social Connectivity: Microsoft Outlook has 'Social Connectors' function that makes it 
really a best communication platform for professionals. With the help of this function you 
will always updated with current activities one has updated through Facebook, twitter and 
LinkedIn profiles. Because all the related information is exhibited in Microsoft Outlook to 
keep the users updated about the recent social activities. 

4) Altered Contacts: MS Outlook stored all contacts in their Address book that can be 
managed in a very smooth way. The most beneficial point for the user is that one can edit or 
change contact information by a single click on its name. As we have seen that Contacts 
have now replaced with "People" in new interfaces. 

5) Tracking Feature: Most of the users want to know that how many peoples have read the 
message sent by them. So MS Outlook has released a new features using it a user can track 
the status of sent email messages. 

6) A new message can be composed, it offers to the users with different two options: 

 "Request a Read Receipt": This function will inform you with a confirmation 
receipt when your email message is being opened by the recipient. 

 "Request a Delivery Receipt": By selecting this option you will aware when the 
message (sent by you) is delivered to the recipient's mailbox. 

Thus, both of the features are used by many users to get back the status of their email. You 
can configure MS Outlook to track entire emails within "Message Handling" section if you 
desire to keep informed with the status of your messages that whether your message 
received or opened. 
7) Customized Calendars: Most of the organizations use MS Outlook Calendars to manage 
appointments, meetings and events, etc. So for now The calendars have been modified and 
altered with a different look that makes it simpler to add organization events, appointments 
and view scheduled. It offers to preview current activities and also to update the status once 
the task is being done. 

It also offers a"weather forecast feature" that shows weather conditions and keeping users 
up-to-date and prepared with the weather situation consequently for local as well as 
outside meetings/appointments. 

8) Inbox Clean Up Tool: This feature of MS Outlook deletes extra spaces from the drive and 
makes email communication more easy as well as effective. The user should assign suitable 
settings to the inbox that will help in saving most recent email message only while deleting 
others. 

9) Shortcuts\ Hot Keys: This is the highly used feature of MS Outlook 2013, which make 
email communication easier and more effective.Shortcut keys are frequently supportive of 
the users who send\ receives a huge quantity of email messages on a regular basis. Using 
Hot keys, user can complete the task in less time and efforts. 

10) Inter-Communication: Microsoft Outlook 2013 allows invite employees as well as co-
workers for the meetings and offers ease for instantly informing others about the 
imperative schedules. This feature informs about the activities (what time they are in and 
out) of the each employee also keeps track of rejected and accepted requests. 
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11) Ribbons & Navigation Bar: Through ribbons and navigation bar user get easier to 
proceed with a particular operation in MS Outlook. Ribbon is also useful for non technical 
users as just by clicking the mouse on a menu bar it will show up all the related features in 
the ribbon area. 

12) Support Microsoft Exchange Server: Most of organizations prefer to set up an Exchange 
server to keep secure email communication and data centralization purpose. MS Outlook 
and MS Exchange server both products are developed by Microsoft and fully supported to 
each other. 

13) Free Import Export Facility: Microsoft Outlook provides a free Import Export Wizard 
that helps users in exporting and Importing data from/to MS Outlook. Through this function 
a user can use MS Outlook data with other email clients. 

14) Manage Rules and Alerts: This is the another strong feature of the MS Outlook, which 
help users to create rules in MS Outlook to send emails to particular filtered folder. Using 
this feature user also can create and manage alerts. 

15) Work Offline: When you switch to work Offline that's mean your Outlook is 
disconnected from the mail server and you will not able to send or receive emails until you 
will switch to working offline to Online in Outlook. 
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UNIT 5 

DESKTOP PUBLISHING 

DEFINITION of DTP 

The desktop publishing is commonly used to describe page layout skills. However the 

skills and software are not limited to paper and book publishing. The same skills and 

software are often used to create graphics for point of sale displays, promotional items, 

trade shows exhibits, retail package designs and outdoor signs. In very simple words, it 

could be said that it is a page maker application. 

Advantages of desktop publishing 

1. Do it yourself desktop publishing helps in saving money. 

2. It allows to have complete control over the final product. 

3. It is easy to make changes. 

4. It gives the user more ways to effectively communicate ideas. 

5. A desktop publishing system allows the user to use different type faces, specify 

various margins and justifications and embed illustrations and graphs directly into 

the text. Desktop publishing system enables the user to see on the display screen 

exactly how the document will appear when printed. System that support this 

feature are called WYSIWYGs (what you see is what you get) 

6. Desktop publishing systems have become more popular for producing newsletters, 

brochures, books and other documents that formerly required a typesetter. 

Computer virus 

Computer viruses, like their biological counterparts, generally trick hosts or other types 

of computers into reproducing copies of the invading organism. They spread from one 

computer to another through electronic bulletin boards, telecommunication systems 

and shared floppy disks. 

Types of Computer viruses 

A. On the basis of damages 

 Boot virus: These viruses infect floppy disk boot records or master boot 

records in hard disks. It works by replacing the first sector on the disk with 

part of itself. It hides rest of itself elsewhere on the disk. With a copy of first 

sector the virus is loaded by the built in program when the machine is 

switched on.  
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 Programme virus: it infects executable programs like .BIN, .COM, .EXE, .DRV 

and .SYS. The virus becomes active in memory, making copies of itself and 

infecting files on disk. 

  Multipartite virus: It is the combination of boot and program viruses. These 

infect program files and when the infected program is executed, and then 

viruses infect the boot record. When boot the computer next time the virus 

from the boot record loads in memory and then starts infecting other 

program files on disk. 

 Stealth virus: It is able to avoid detection by variety of means such as 

removing itself from the system registry, masquerading as a system file etc. 

 Parasitic virus: These viruses attach themselves to other programs and are 

activated when the host program is executed. It spreads to other computers 

when the affected programs are copied. It embeds itself into another file or 

program such that the original file is still viable.  

 Polymorphic virus: It changes its code structure to avoid detection and 

removal. 

 Macro virus: A macro virus is a new type of computer virus that infects the 

macros within a document or template. When you open a word processing or 

spread sheet document, the macro virus is activated and it infects the normal 

template-a general purpose file that stores default document formatting 

settings. 

B. On the basis of function and propagation 

 Trojan horse: Trojan horse are the files that provide the attackers with 

remote access to the victim’s computers. 

 Worm: A worm is a small piece of software that uses computer networks and 

security holes to replicate itself. It spreads through network for another 

machine that has a specific security hole. It duplicate itself and finally 

clogging the entire system with copies. 

 Bomb: Bomb doesn’t propagate itself at all, but is placed by human or 

another program and activated by trigger such as time or event. Usually it 

does something unpleasant when it goes off.  

 Port scanner: Port scanner is hides on a system and scans the surrounding 

environment IP addresses and open ports that makes available to other 

malicious code or individuals. 

Internet  

The internet can be defined as a large network that connects other networks of computers 

all around the world.  

Definitions of internet 
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 It is a set of computers talking over fiber optics, phone lines, satellite links, and other 

media. 

 It is a place where you can talk to your friends and family around the world. 

 It is a gold mine of professionals in all fields sharing information about their work. 

 It is hundreds of libraries and archives that will open to your finger tips. 

Advantages of internet 

 E-mail: E-mail is now an essential communication tools in business. It is also 

excellent for keeping in touch with family and friends. The advantages to e-mail are 

that it is free when compared to telephone, fax and postal services. 

 Information: there is a huge amount of information available on the internet for just 

about every subject known to man, ranging from government law and services, 

trade fairs and conferences, market information, new ideas and technical support. 

 Services: Many services are now provided on the internet such as online banking, job 

seeking and applications, and hotel reservations. Often these services are not 

available off line or cost more. 

 E-commerce: E-commerce is the concept used for any type of commercial 

manoeuvrings or business deals that involves the transfer of information across the 

globe via internet. It has become a phenomenon associated with any kind of 

shopping, almost anything.  

 Communities: Communities of all types have sprung up on the internet. It’s a great 

way to meet up with people of similar interest and discuss common issues.  

Drawbacks of internet 

 Theft of personal information: If you see internet, you may be facing grave danger 

as your personal information such as name, address, credit card number, etc, can be 

accessed by other culprits to make your problems worse. 

 Spamming: spamming refers to sending unwanted e-mails in bulk, which provide no 

purpose and needlessly obstruct the entire system. Such illegal activities can be very 

frustrating for you, and so instead of just ignoring it, you should make an effort to try 

and stop these activities so that using the internet can become that much safer.  

 Virus threat: Virus is nothing but a programme, which disrupts the normal 

functioning of your computer systems. Computers attached to internet are more 

prone to virus attacks and they can end up into crashing your whole hard disk, 

causing you considerable headache. 

 Pornography: this is perhaps the biggest threat related to your children’s healthy 

mental life. This is very serious issue concerning the internet. There are thousands of 

pornographic sites on the internet that can be easily found and can be a detrimental 

factor to letting children use the internet. 

E-mail 
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Short for electronic mail, e-mail is information stored on a computer that is exchanged 

between two users over telecommunications. 

 

Advantages of E-Mails 

 Emails are very easy to use. You can organise your daily correspondence, send and 

receive electronic messages and save them on computers. 

 Emails are fast. They are delivered at once around the world. No other form of 

written communication is as fast as an email. 

 The language used in emails is simple and informal. 

 When you reply to an email you can attach the original message so that when you 

answer the recipient knows what you are talking about. 

 It is possible to send automated emails with a certain text. In such a way it is possible 

to tell the sender that you are on vacation. These are called auto responders. 

 Emails do not use paper. They are environment friendly and save a lot of trees from 

being cut down. 

 Emails can also have pictures in them. You can send birthday cards or newsletters as 

emails. 

 Products can be advertised with emails. Companies can reach a lot of people and 

inform them in a short time. 

Disadvantages of E-Mails 

 Emails may carry viruses. These are small programs that harm your computer 

system. They can read out your email address book and send themselves to a 

number of people around the world. 

 Many people send unwanted emails to others. These are called spam mails. It takes 

a lot of time to filter out the unwanted emails from those that are really important. 

 Emails cannot really be used for official business documents. They may be lost and 

you cannot sign them. 

 Your mailbox may get flooded with emails after a certain time so you have to empty 

it from time to time. 

Designing Web Page 

The method to create a web page is as follows: 

Step-1: Open a notepad 

Step-2: Type the following tags in the notepad 

i. HTML –It indicates the beginning of HTML document  
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ii. HEAD – It is use to start the header section. All the information related to web page 

is entered in between the opening and closing of head type 

iii. TITLE – It indicates the opening of the title tag and the matter that appears on the 

title bar is displayed between the opening and closing of title tag 

iv. /TITLE – It indicates the closing of the title tag 

v. /HEAD – It indicates the closing of the head tag 

vi. BODY – It indicates the opening of body tag. All the matter that the user wants to 

display on the web page is typed between the opening and closing of the body 

tags 

vii. /BODY – It indicates the closing of body tag 

viii. /HTML – It indicates the end of the html document 

Step-3 Once the tags are entered, the next step is to save the notepad file. The file should 

be given ‘html’ extension. 

Step-4 After the file is saved, the next step is close the notepad. 

Step-5 Open the file that has been created by double click on the icon. It will open in the 

default browser.  
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Unit 6 

Accounting software 

Computerised accounting 

The computer accounting system is based on the concept of databases. It does away with 

the concept of creating and maintaining journals, ledgers etc. which is essential while 

working with manual accounting system. 

Typically computerised accounting system offers the following features: 

1. Online input and storage of accounting data. 

2. Computerised accounting system can be operated in a simple and easy manner. It 

requires only some sort of skills in data entry and knowledge in accounting principles 

and concepts. 

3. Printout of purchase and sales invoices. 

4. Logical scheme for codification of accounts and transactions. Every account and 

transaction is assigned a unique code. 

5. Grouping of accounts is done from the very beginning. 

Advantages of Computerised accounting 

1. Simplicity: It is one of the most simple and complete business solutions available in 

the world. Anybody who has a basic knowledge of accounts or an average 

knowledge of English can use computerised accounting. 

2. Speed: It can get any reports instantaneously for any date/period and can get toggle 

between reports, either accounting or inventory or even from one company to 

another company instantaneously. 

3. Power: It has the power to generate management information, which would help 

the management in taking correct decisions. This in turn would enable faster growth 

of business. 

4. Flexibility: It is very flexible to use. It mimics the human thought process, i.e. it can 

adapt to any business needs rather than the user trying to change the way his 

business in run to adapt to the package. 

5. Real time: It updates all reports as and when the transaction are entered and hence 

does not need any back end or day/period end process to be done. 
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6. Online help: It provides user friendly context sensitive online help for the user. 

Disadvantages of Computerised account 

1. Customising the accounting packages is not easy. 

2. More expensive.  

3. Constant pressure for updating hardware and software system. 

4. Security of data sometimes becomes risky. 

5. Lacks of deficient employers. 

Manual Accounting V/S Computerised Accounting 

Sl no Manual accounting Computerised accounting 

1 Lengthy process. Entries to be done in 
various ledgers. For a single entry, 
multiple ledgers are to be opened 

Brief process. A single entry in one 
account updates all other accounts 
automatically. 

2 Slow process. Fast process. 

3 More than one person involved in 
handling various account books 

A single person can handle the 
transactions. 

4 Error prone. Accuracy may not be 
100%. 

100% accuracy. 

5 Easy to audit manual accounts Auditing of accounts is difficult. 

6 Stationary items less costly. Stationary items very costly. 

7 Time consuming process. Time saving process. 

8 No fear of itself data damaging. Fear of data damaging due to hard disk 
crash, virus problem, power failure etc. 

 

Tally software 

Tally is business accounting software. It is one of the well-known as well as highly 

acceptable software. Tally use for simple accounting like complete book keeping books, 

registers and statement of accounts, general ledger, credit control, account receivables and 

payable, bird’s eye view/Drill down display data based reporting, voucher and cheque 

printing, columnar report and bank reconciliation. 

Features of Tally Software 

The features of tally software divided into four sectors they are- 

A. Accounting features 

B. Integrated enterprise features 

C. Inventory features 

D. Performance and implementation features 
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A. Accounting features 

 Accounting without CODES: Tally enables the user to do accounts by using 

regular names. The user need not know the accounting codes to use tally. 

 Comprehensive accounting: The user can instantly obtain Balance sheets, profit 

and loss statements, cash and fund flows, trial balance and others. 

 Complete book keeping: Tally records all types of transactions including receipts, 

payments, income and expenses, sales and purchases, debit notes, credit notes, 

adjustment journals, memorandum journals as well as reversing journals. 

 Multi-currency accounting: The user can have the flexibility of multiple 

currencies in the same transaction, and viewing all reports in one or more 

currency. 

 Unified ledgers: Tally pioneered the concept of unified ledger where the general, 

sales and purchases are integrated into single ledger and organized in group 

management. 

 Receivables and payables: Tally dynamically allocates payments against invoices 

with reference to due dates. 

 Budgeting, auditing and security control: Tally provides unlimited budgets and 

periods, user definable security levels for access control and powerful audit 

capabilities. 

B. Integrated enterprise features 

 Multi-location stock control: Tally provides the option for simple single location 

or complex multi-location stocks. 

 Comprehensive recording of stock movement: All sorts of inventory transactions 

can be recorded using the inventory voucher forms that make inventory 

recording very easy and comprehensive. 

 Variety of management reports: Movements analysis give party-wise details of 

goods bought, sold, and help identify good and bad business partners.  

C. Inventory features 

 Synchronization: It helps the user to transfer data between two or more 

locations, eg., All data from branch office gets transmitted to head office and 

visa-versa. 

 The user can e-mail reports and documents directly from Tally, helps to consume 

postage cost and valuable time. 

 The user can publish reports on web by HTML or internet and easily share them 

with suppliers, customers or own staff. 

 Direct web browsing capability helps the user to avoid switching between 

programs. 

 The user can exchange data with other system using XML. 

 ODBC connectivity: This enables the user to integrate Tally data dynamically into 

ODBC systems.  
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D. Performance and implementation features 

 Rapid implementation: It means nil to low start-up costs, with the lowest training 

requirements of any accounting system in the world. 

 Real time processing: Tally updated all the books, ledgers and reports as soon as 

a transaction is accepted. 

 Blazing speed: Tally outdistances all systems with its faster than thought 

performances. 

 Work on platform and network user choice: Tally works on all flavors of windows. 

 Unlimited companies and periods of accounting: Tally can handle the accounts of 

more than one company as well as compare across companies and final periods. 

 Unbelievable period end handling: This unique date driven approach of tally, 

with dynamic and automatic periods, makes it the single most important reason 

why accounts should be maintained on tally. 

 Dynamic interactive reports and unique drill down facility: All reports are 

dynamic and allow further interrogation from summary to the actual transaction 

voucher. No report is a dull print to screen output. 

 Print preview from within tally helps the user to view reports and their layout, 

prior to actual printing. 

Advantages of Tally technology 

Data reliability 

Tally offers extremely high reliability data with extremely compact and database. If there is 

a power failure or if the machine is shutdown, the system is still functioning and there will 

be no data loss 

Data security 

Tally use of data integrity checks ensures that there no external change to the data can pass 

through tally. 

Tally audit  

Tally audit feature provides the user with administrator rights, a capability to audit for the 

correctness of the entries made by authorized users and alter them if needed. 

Tally vault 

Tally offers a data encryption option, which is called Tally vault. The Tally vault password 

given cannot be broken by any means. Tally follows DES (Data Encryption Standard) 

encryption method. 
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Use defined security levels 

Tally offers high levels of security. The user can define multiple levels of security as per his 

requirements and have individual passwords. 

Simple and rapid installation 

Tally has a simple menu driven installation procedure. At the time of installation the user 

can select to install the program files on any drive as well as specify the directory names 

where the program files are to be installed.  

Unlimited Multi-user support 

A multi-user version of tally can be installed on a network having any number of machines 

working with different operating systems like Windows NT, 95,98,2000. 

Internal backup/restore 

Tally has an in built user friendly backup and restore option to take a backup in the local 

hard disk or in any external media of one or more companies or all companies in a single 

directory. 

Removal of data into separate company 

Tally offers a feature of splitting company data. Tally allows users to maintain a company for 

any number of financial years. Once the books of accounts are completed for previous 

financial years and if the user wishes, he could split the company data into multiple 

companies as per financial periods required.   

Multi directory for company management 

The user can create multiple directories to store data, which can be accessed directly by 

tally after specifying the path. 

Import tally data / export tally data 

Tally allows users to import data from other software as well as export data from tally to 

other software.   

Graphical analysis of tally data 

Tally also provides graphical analysis of data because pictures can say better than figures. 

Scenario management 

The new Scenario management capability allows planning, as well as analyzing business 

performance, under varying assumptions. Use this feature for forecasting and planning, 
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prepare reports including provisional figures without affecting actual accounts, using 

automatically reversing journals. 

Web enabled 

This will help the user in reducing his paper work. Now a day, not only report but also 

invoices and purchase orders can be e-mailed directly from tally.  

Ability to publish reports and documents on the internet 

Now a day, tally allows users to upload reports on website directly. Many companies would 

also like to publish their reports and price list on their websites along with the product they 

deal with. 

Print preview 

Tally now offers a facility of print preview. Now any reports/invoices/vouchers can be 

viewed before printing or before it is mailed. 

Cutting edge technology 

Tally has achieved major technological break thoughts to enable to benefit from 

collaborative technology such as protocol support for HTTP, HTTPS, FTP, STMP, ODBS etc. 

Direct internet access 

Tally now offers direct internet access. A tally user while working on tally can directly log on 

to tally website get details of all the facilities offered by tally. 

Benefits of Tally Software 

1. Simplicity: It is one of the most simple and complete business solutions available in 

the world. Anybody who has a basic knowledge of accounts or an average 

knowledge of English can use computerised accounting. 

2. Speed: It can get any reports instantaneously for any date/period and can get toggle 

between reports, either accounting or inventory or even from one company to 

another company instantaneously. 

3. Power: It has the power to generate management information, which would help 

the management in taking correct decisions. This in turn would enable faster growth 

of business. 

4. Flexibility: It is very flexible to use. It mimics the human thought process, i.e. it can 

adapt to any business needs rather than the user trying to change the way his 

business in run to adapt to the package. 

5. No codes: Tally was the first accounting package in the world to introduce the no 

codes concept for accounts. Tally accepts alphanumeric character for accounts and 

inventory masters and hence any accounts or stock items can be created and 
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identified by their names. The codeless concept introduced by tally is now the widely 

accepted norms across the world today. In case the user wants to use codes, tally 

supports that too. 

6. Sheer power: Tally has the ability to handle huge volumes of transactions without 

compromising on speed or efficiency. 

7. Real time: It updates all reports as and when the transaction are entered and hence 

does not need any back end or day/period end process to be done. 

8. Online help: It provides user friendly context sensitive online help for the user. 

9. Expanding business: With the concurrent multi-lingual capability and multi-currency 

features that allow you to transact beyond geographical boundaries, without 

language barriers. 

10. Amazing accuracy: Tally provides user-definable templates for fast, accurate data 

entry. 

 

System / Hardware requirements for Tally software (version 9) 

a) Processor –Intel Pentium IV and above 

b) Memory -256 MB RAM or more 

c) Free hard disk space -40 MB Minimum 

d) Monitor resolution -1024 X 768 or higher 

e) Operating system –Microsoft  Windows 98/ME/NT/2000/XP/2003/Vista 

Higher memory is recommended for enhanced performance in report generation. Higher 

disk space is recommended for large volumes of data. 

Installation of Tally software 

Installation of Tally software is having two types of licencing policies they are- 

i. “Tally silver” for single user 

ii. “Tally gold” for multi user 

i. Tally silver for single user 

The single user licencing allows deploying Tally on one computer only, with two option of 

activating “online” or “off-line”. However the some licence can use another computer. 

But for that first surrender the existing licence activated on the first computer and then 

reactivating it on the other computer. 

ii. Tally gold for multi user 

A multi user version (gold) of Tally can be installed on a network having any number of 

machines (computers) working with different operating systems like NT, WIN 95, 98, 

WIN 2000. 
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Installation Tally 9 silver 

1. Insert Tally 9 silver CD in CD-ROM drive. Tally 9installation wizard is displayed. 

2. Click next to go to license agreement screen. The license agreement screen is displayed. 

3. Read the license agreement before you proceed. Click I agree to continue to go to the 

set up screen. Click I decline to stop the set up or click back to go to the previous screen. 

4. The Tally 9 set up screen is displayed. In the installation screen, you may accept the 

suggested directories. Else, click change application directory or change data directory or 

change configuration directory or change language directory to change the respective 

directory paths. Use tab or the mouse to change the path in any of the directories. 

5. Click next to go to the country /language selection screen. 

6. From the country/language selection screen, select the country of your residence and 

the default language in which Tally should start. Based on the country selected, the 

required statutory files will be loaded. 

7. Click install. The installation progress status is displayed. Once installation is complete, 

the installation completion screen is displayed. 

8. Click finish to complete the installation. 

 

 

Installation Tally 9 gold 

1. Insert Tally 9 gold CD in the CD ROM drive. Tally 9 installation wizard is displayed. 

2. Click next to go to license agreement screen. The license agreement screen is displayed. 

3. Read the license agreement before you proceed. Click I agree to continue to go to the 

set up screen. Click I decline to stop the set up or click back to go to the previous screen. 

4. In the programs section check licence server, the licence server setup section appears. 

The Tally 9 set up screen is displayed. 

5. By default a folder name Tally is created in the drive where the operating system is 

installed on your computer are 9090 is the default port. To change the default licence 

server directory, click on the button provided and select the required directory, enter 

the port number in port. 

6. Click on install. 

7. The installation progress status is displayed. Once the installation is complete, the 

installation completion screen is displayed. 

8. Click finish to complete the installation. 
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Create a New Company 

A. Select create company from company info menu. The company creation screen is 

displayed. 

B. The name is used for selecting the company where as the mailing name is used for 

printing reports and vouchers. 

C. Statutory compliance for is available for India, Indonesia, Malaysia, Philippines, 

Singapore and United Kingdom. The user has to select the required country from the 

list of countries for which statutory compliance has to be met. This will impact the 

taxation and base currency. 

D. Select the required state from list of states available, Tally will load the state specific 

taxation. 

E. Select the accounts only in the maintain field to record only accounting transactions 

or accounts with inventory to record both accounting and inventory transactions. 

F. Financial year from indicates the beginning of the financial yearof the company. Tally 

considers 12 months from the date provided ass the financial year. 

G. Provide the date from which wish to maintain the books in the books beginning from 

field. This helps when you are implementing tally in the middle of a financial year. 

H. You may provide a password in tally vault password field to maintain confidentiality 

by encrypting the data. 

I. In order to provide access to a particular company data, type Yes in the field Use 

Security Control. The Name of Administrator, Password, Repeat and Use Tally Audit 

Features field will appear. Provide Name of Administrator, Password and retype the 

password in repeat field. Type yes in the use Tally Audit features field. This will 

enable the administrator or the auditor to track changes in the financial statement. 

J. On completing the information, Tally seeks conformation to save the company 

profile by asking – Accept? – Yes or No 

Press Y or Enter to accept the Parameters provided to complete the company 

creation. 

K. On successful creation of the company, Tally returns to Gateway of Tally and the 

newly created company loaded. 

The company data will be stored in the default Tally directory. 

 

Voucher entry/ creating a Voucher 

A voucher is the basic recording document. To input any data into Tally, you must use a 

voucher. Inputting data through the voucher entry mode may called Creating Voucher or 

Voucher entry. You may create a voucher online on Tally and print it for hard copy and 

authentication. 
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The procedures to create a new voucher type are  

Gateway of Tally → Accounting Vouchers.     This will open the Accounting Voucher Creation 

Screen. 

Or  

Select Accounts info → Voucher Type →Create 

Types of Voucher 

Purchase voucher –It records all the purchase entries. If inventory values are affected for 

purchase accounts in case of accounts with inventory companies, item details must be 

given. To enter the values into purchase voucher follow the steps. 

Gateway of Tally → Accounts Voucher →click Alt F9 or purchase button from button bar. 

Sales voucher–It records all sales entries related to sales. We need to enter the item details 

if inventory values get affected due to sales. To enter the values into sales voucher follow 

the steps 

Gateway of Tally → Inventory Voucher →Click Alt F8 or sales button from button bar 

Contra voucher–It involves fund transfers between cash and bank accounts only. 

Example : Transfer of funds or cash from one bank to another bank. 

The steps involved in creation of this voucher is  

Gateway of Tally → Accounting voucher → click Alt F4 or contra button from button bar. 

Payment voucher –This voucher records all the entries of payments made through bank and 

cash. 

Gateway of Tally → Inventory voucher → click Alt F5 

Receipt voucher –This receipt voucher records all the receipts into bank or cash accounts. 


	Top 15 Features Of Microsoft Outlook

